
 1 

Noise Ninja 2 User's Guide 
This document describes the general operation and key features of PictureCode's Noise Ninja image noise 
reduction software.  
 
A complementary source of information is "What's This?" popup help in the software. Click the "What's 
This?" button in the Noise Ninja toolbar or in a dialog box, and then click on an item in the user interface to 
view a description of the item. 
 
 
Copyright © 2004 by PictureCode LLC. All rights reserved. "Noise Ninja" and "Noise Brush" are 
trademarks of PictureCode. The Noise Ninja software application includes patent-pending technologies. 
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The five-minute guide to Noise Ninja 2 
For first-time users of Noise Ninja, this section provides a tutorial introduction to the noise reduction 
workflow. While it does not cover Noise Ninja in depth, it covers the most important points, and it should 
be enough to allow you to start using the tool productively within a few minutes.  

The earlier, the better 

As a general principle, you should apply noise reduction as early as is practical in your workflow — 
ideally, before other editing operations like tone adjustment, color balancing, sharpening, or resizing. 
Adjustments like these can shift pixel values and distort noise levels in unpredictable ways, and this can 
make it more difficult for Noise Ninja to remove the noise effectively. Sharpening and resizing, in 
particular, should be deferred until after noise reduction when possible. (Modest amounts of in-camera 
sharpening are usually okay, however.) 

Step 1. Open an image 

To load an image, click on the File Open button in the window toolbar: 

 

Currently, Noise Ninja can read JPEG and uncompressed TIFF images.  

Step 2: Create or load a noise profile 

A noise profile characterizes how much noise is present for different colors and brightness levels in an 
image. For instance, a noise profile can represent the fact that there is more noise in shadow areas than in 
highlights, or more noise in reds than in yellows. Noise profiles are the key to getting good results with 
Noise Ninja, because noise levels are different for every camera and scanner, and for different values of 
ISO sensitivity and other settings. 

First, activate the Noise Profiler by clicking on the Noise Profile selector button: 

 

Next, do one of the following: 

• Create a noise profile from the image Click the Quick Auto Profile button to create a noise 
profile directly from the current image:  
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This is okay for "quick and dirty" work, but the automatic profiler can be fooled by some textures. 
Also, some images have too much detail in certain tones or colors, making it hard to create an 
accurate profile. You will normally obtain more consistent results, and your workflow will be 
more productive, if you profile your camera (or obtain profiles from someone else) and reuse those 
profiles when you are filtering images. (See below.) 

• Load an existing profile Click on the Open Profile button to load an existing profile: 
 

 
 
You can download profiles for many cameras from www.picturecode.com/profiles.htm You can 
also create your own profiles quickly and easily using a profiling chart that is included with Noise 
Ninja. See “Profiling a camera or scanner” for details. Creating your own profiles allows you to 
customize them to your particular preferences regarding camera settings and other variables. It 
only takes a few minutes, and it is simple to do.  

For the moment, you can just click the "Quick Auto Profile" button. When you have time, you are 
encouraged to read “Introduction to Noise Profiles” and “The Automatic Profile Loader”. 

Step 3: Remove noise 

After you have created or loaded a noise profile, activate the Noise Filter tool. This tool uses the noise 
profile to suppress noise from the image: 

 

If you don't see a green preview rectangle, click in the image to activate it and position it.  You can turn it 
off by right-clicking in the image, or by toggling the Preview button: 

 

Next, adjust the sliders until you like the results shown in the preview area. Each time you adjust a slider, 
the preview will be updated to show the effect of the adjustment. You can toggle the preview to see the 
unfiltered image. 

There are three groups of sliders on the Noise Filter page. The Luminance group affects filtering of noise 
in the brightness component of an image. This is usually the part of the image that contains the most real 
information. The Colors group controls filtering of color noise, which is often the most annoying noise. 
The Sharpness group enhances edge sharpness using an unsharp mask. 
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Strength controls how aggressively the filter is applied. This is the control that you'll 
normally want to adjust if you don't like what you see in the preview rectangle. If you 
move it far to the right, the image may look too smooth. If you move it to the left, it will 
look more grainy. Often the most natural-looking results are achieved when you leave a 
modest amount of grain. The human eye tolerates a certain amount of noise when it is 
accompanied by detail, and the luminance channel contains most of the detail in an 
image. 

Smoothness increases or decreases the noise levels estimated by the Noise Profile. 
Usually the default setting is adequate, but if you see isolated specks in smooth areas, try 
increasing the smoothness setting to see if they go away. (Here's a tip for adjusting the 
Smoothness slider: Move the preview window to a smooth background areas, and move 
the Strength slider all the way to the right so the preview is a smooth as possible. Then 
set the Smoothness slider to the minimum level such that the preview is still smooth (if it 
is too low, you will usually see isolated specks). Finally, lower the Strength slider until 
you like the results.) 

Contrast and saturation apply a scaling factor to edges, similar to an unsharp mask, but 
at several resolutions simultaneously. You probably won't need to adjust these in most 
situations. 

Sharpness amount and sharpness radius apply a conventional unsharp mask to the 
filtered image. Some people prefer to set the amount to zero and do sharpening later in 
the workflow. However, even in that case, it can be useful to preview the sharpening 
effect to see how it interacts with the noise reduction. The Suppress halos option 
eliminates unnatural highlight artifacts that can occur when high sharpening levels are 
used. 

Here is a simple strategy for adjusting the Luminance sliders that usually yields good results:  

1. Set the Luminance Strength slider all the way to the right 

2. Set the Luminance Smoothness slider to the lowest level that results in a smooth area 
without obvious speckling. 

3. Reduce the Luminance Strength slider until you like the balance between noise 
reduction and detail preservation. 

When you are satisfied with the slider settings, press the Remove Noise button to apply filter to the entire 
image: 

 

After filtering, you can use the Before button to toggle between the original image with the filtered version: 

 

Press and hold the button to view the unfiltered image. 
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Step 4: Refine results with the Noise Brush™ 

The Noise Brush tool allows selective undo or fading of noise reduction. To use it, activate it by clicking on 
the Noise Brush tool selector button: 

 

Next, use the mouse to paint on areas where you want to touch-up the results of filtering. This is typically 
useful for hair or fine texture, which is often difficult to distinguish from noise.There are a number of 
controls in the tool panel for changing the size and operation of the brush.  

You can apply the Noise Brush to the luminance channel, color channels, or all channels. Usually, you'll 
obtain the best results by working in the luminance channel. This will allow you to touch-up detail without 
reintroducing color speckles.  

You can flip the brush mode from undo to redo, or vice-versa, by right-clicking, alt-clicking, or control-
clicking. You can also undo and redo individual brush strokes or all brush strokes by clicking on the 
appropriate buttons: 

 

Step 5: Save your work 

When you are finished processing an image, save it to your hard disk with the Save As command: 

. 

Note that your images will be watermarked with a gray grid when you save them, unless you install a valid 
license key. See “Installing a license key” for more information. 

If you want to go back and try filtering the image with different settings, invoke the Undo command in the 
Edit menu (or press Ctrl-Z), and then go back to Step 3. 

Beyond the basics 

Once you've gotten comfortable with the basic operation of Noise Ninja, here are some other features and 
capabilities that you should explore: 

• Configuration The Preferences dialog (in the Noise Ninja menu on Macintosh, or in the Edit 
menu on Windows) contains a variety of settings for controlling the performance, behavior and 
appearance of Noise Ninja. 
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• "What's This?" help The user interface is annotated with "What's This?" pop-up help. To use it, 
click on the What's This button:  
 

        
 
Then click on an item in the user interface to see a description. Alternatively, move the mouse 
over an item, and then press the F2 key. Note that What's This help is usually more detailed than 
the tooltips that display when you hover the mouse.  

• Overview buttons Several tools and dialogs have Overview buttons:  
 

       
 
When you see an Overview button click on it to read an introduction to the corresponding tool or 
dialog box. 

• Shortcuts There are a number of keyboard and mouse shortcuts listed on the “Shortcuts” page. 

• Batch processing You can use the Batch Processor dialog (in the File menu) to process an entire 
directory of images automatically. The batch processor includes flexible options for selecting 
profiles and controlling filtering. 

• Other features Noise Ninja includes functions for rotating images, viewing image metadata like 
EXIF or IPTC data, annotating noise profiles, and viewing multiple images. See “Miscellaneous 
features” for an overview. More information can be found by accessing the What's This help for 
these features.  
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An overview of Noise Ninja 
Noise Ninja is an effective, productive tool for removing noise and grain from digital images. It 
incorporates sophisticated, patent-pending technology to suppress noise while preserving detail.. The result 
is typically up to a two-stop improvement in effective image quality, making images more suitable for 
publication and enlargement. 

What is noise? 

Noise is the digital equivalent of film grain. It can even look like grain, though more often it looks like ugly 
speckles or color artifacts. It results from a variety of sources, including sampling errors in pixels, 
temperature-induced "dark current" in sensor elements, and signal amplification circuits. While film grain 
often has a pleasant aesthetic quality to it, digital noise usually detracts from an image.  

The following photographs show typical noise in digital photographs, along with the results of removing 
the noise using Noise Ninja: 
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Noise is usually most accute when a digital camera is set to a high ISO sensitivity, which is often required 
when shooting indoors or at fast-action sporting events. However, even at low ISO settings, noise may 
become intrusive when an image is enlarged. Nearly all current compact cameras show strong noise at ISO 
400, and high-quality digital SLRs by ISO 1600.  

Film scanners are also well known for introducing noise into digitized images, especially in dark areas of 
slides and in the blue channel. 

Noise is an inherent property of digital imaging sensors. The laws of physics make it impossible to 
completely eliminate noise, and they force a tradeoff between noise levels and other properties like sensor 
size or sensitivity. Photons, for instance, arrive at random intervals, so the simple task of counting them 
during an exposure-- which is the basic function of a pixel in a sensor -- is subject to sampling error. When 
the exposure is shortened or the pixel size is reduced, there are fewer photons to "average out" the sampling 
error, so the noise increases relative to the signal. 

The small sensors in compact digital cameras are more prone to noise than the large sensors used for digital 
SLRs. Compact digicams often have as many pixels as their DSLR brethren, but those pixels are packed 
into one quarter the space -- or even less. So, for any given exposure, many fewer photons reach each pixel 
in the smaller sensor than in the larger one, and this leads to correspondingly higher noise. So, the noise in 
a compact camera at ISO 200 might be the same as the noise in a DSLR at ISO 800. By the same 
reasoning, an 8-megapixel camera might have much higher noise levels than a 4-megapixel camera if both 
have the same sensor size.  

What Noise Ninja can and can't do 

Noise Ninja is designed to be most effective at removing noise that is both random and uniform. "Random" 
essentially means that there aren't patterns in the noise. "Uniform" means that, for similar colors and tones, 
noise is distributed throughout the image at roughly the same amplitude. That is, the noise should not be 
high in one corner of the image and low in another unless the variation is due to differences in color or 
tone. 

Noise Ninja may yield acceptable results when these conditions are relaxed. But the more the conditions 
are weakened, the less effective Noise Ninja is likely to be. For instance, stuck pixels, dust, and scratches 
are not uniformly distributed through an image -- they are localized to a few spots.  
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Noise Ninja can often work in conjunction with in-camera noise reduction. For instance, many digital SLRs 
have an option to use "dark frame subtraction" for long exposure noise reduction. This can remove a 
significant amount of noise that is repeatable from one frame to the next, and then Noise Ninja can be used 
to suppress the residual noise. Likewise, at least one popular RAW conversion tool has a simple noise-
reduction feature that seems to work nicely together with Noise Ninja. 
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System Requirements  
Noise Ninja is an inherently computing-intensive software application. Generally speaking, the faster your 
computer and the more memory available, the better Noise Ninja will perform. Below, we describe the 
minimum and recommended computer configuration for using Noise Ninja. 

Operating system 

Noise Ninja runs on the following operating systems: 

• Mac OS X 10.2 and later  
• Microsoft Windows 98SE, Me, 2000, and XP  

CPU 

For Windows, a Pentium-compatible processor is required, and a Pentium III or better processor is highly 
recommended.  

For Macintosh, a G3 processor is the minimum supported, and a G4 or better processor is highly 
recommended.  

Best peformance will be obtained with 1GHz or faster processors. Noise Ninja is particularly optimized to 
exploit advanced features on the Pentium 4 and G5 processors. 

RAM 

Noise Ninja uses a disk-backed caching system that can process large images in modest amounts of 
memory. However, performance will be best when plenty of free memory is available. As a rule of thumb, 
it is best to have roughly 20 bytes of free memory per image pixel. So, for a 6 megapixel image, 120 
megabytes of free RAM should yield good results. 

Hard disk space 

Noise Ninja uses the hard disk as a "scratch area" to temporarily store image data that it can't fit in RAM. 
The amount of free disk space that you need depends on the size of images that you intend to process and 
the amount of RAM available to Noise Ninja. As a rough guideline, figure on needing around 96 
megabytes for a 6 megapixel image, and more if you intend to open several images at once.  

In the Preferences dialog, you can specify the location for the scratch area. Ideally, you should specify a 
disk that has several gigabytes of free space. 
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Installing a license key 
The Noise Ninja software application is freely distributable. However, certain features of the software are 
disabled unless a valid license key is installed: 

• Images are watermarked with a gray grid when they are saved  
• Batch processing is disabled.  
• 16-bit TIFF output is disabled.  
• Multiprocessing support is disabled.  

If you purchased Noise Ninja at a retail store, then it probably came with a sticker containing a license key. 
If you downloaded Noise Ninja from the Internet, you can purchase a license online at 
www.picturecode.com and receive the key via email.  

A license key contains two parts: a user name, and a keycode. To install a license, select the "Install and 
view license" command in the Help menu. When the license dialog is displayed, type or paste the user 
name in the User name field of the dialog: 

 

Next, type or paste the 30-digit keycode, including hyphens, in the Keycode field: 

 

Now press the Install key. You will be asked to accept a license agreement. Read it and accept it to 
continue installation of the license key.  

If your license key is valid and was entered correctly, then you should see a dialog indicating that the 
license was installed. If not, then re-enter the key, checking it carefully for typographical errors.  

A license can also be rejected if your system clock has been set back to a date before the license was 
issued. If this is the case, update your clock to the correct time and date, and try again to install the key. 
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Configuration and the Preferences dialog 
A variety of configuration options are available in the Preferences dialog. These options affect the 
performance, behavior, and appearance of Noise Ninja.  

On Macintosh, you can access the Preferences dialog in the Noise Ninja menu. On Windows, it is located 
in the Edit menu. The dialog has overview buttons on each page that you can click for basic help. You can 
also use the "What's This" help to obtain descriptions of individual options. 

Image cache 

 

Set the "RAM usage" slider on the Image Cache page to an amount that is appropriate for your computer. 
Generally speaking, the more memory you allocate to Noise Ninja, the faster and more smoothly it will run. 
However, Noise Ninja uses some sophisticated caching and disk swapping schemes that allow it to process 
large images even when memory is limited. 256 to 512 megabytes should be adequate for most users. After 
you have set the memory usage level, restart Noise Ninja so the change will take effect.  

Tip: A rule of thumb is to allocate 20 bytes per pixel. If you are filtering a 6 megapixel 
image, for instance, then try to have at least 120 megabytes allocated to Noise Ninja's 
image cache. 

Noise Ninja creates a scratch file to hold image data that doesn't fit in memory. The scratch file is deleted 
automatically when Noise Ninja terminates. By default, it is located in a system temporary directory, and 
this is usually fine. If you want, you can change the scratch file location by clicking on the "Change" button 
on the Image Cache page. The scratch file can grow very large if you open many images at once or if you 
work with large film scans, so be sure to locate it on a volume with plenty of free space. Also, make sure to 
choose a directory where you have permission to create files. 

File Save behavior 
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On the File Save Behavior page, you can control what happens each time you save a file.  

"Invoke Save As on first Save" will display the Save As dialog the first time you try to use the "Save" 
function for a dialog. This can help to prevent accidental overwrites.  

The option to "Remember directory for Save As" causes Noise Ninja to open the Save As dialog in the 
same location where the last Save As operation took place. This allows you to open original files in one 
directory and save filtered files in another without having to navigate back and forth each time.  

The "Default suffix for Save As" is automatically appended to the current file name when you invoke the 
Save As command. You can still edit the name in the Save dialog. Also, the suffix is not added if it is 
already present in the file name. 

If you enable the "Show Tiff options dialog" or "Show Jpeg options dialog" options, then a dialog will 
allow you to configure various file attributes each time you use the Save As function. However, you might 
find it more convenient to configure these settings once by pushing the "Set options" buttons, and then clear 
the checkboxes. This will prevent the dialogs from being displayed when you use the Save As command. 

Noise profiles 
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On the Profiles page, there are options to control saving and automatic loading of noise profiles.  

The option to "Propose a name based on annotations" will automatically generate a profile name using 
the Manufacturer, Model, ISO, and other annotation values if they are present in a noise profile. This 
naming scheme is completely optional, it will not affect the operation of Noise Ninja in any way.  

The option to "Create folders automatically" should be enabled if you are using the automatic profile 
loader. It uses the Manufacturer and Model annotations in a profile to propose a location for a profile when 
you save it. This will help to ensure that profiles are stored where the auto loader can find them.  

The Profiles page also contains a checkbox to "Auto-load best-match profile" This controls the automatic 
profile loader. Check this box if you would like Noise Ninja to select and load profiles automatically when 
you open an image. 

Multiprocessing 

 

Multiprocessing allows noise removal and profiling to run on more than one processor to accelerate 
computation. It requires that you have a computer with two or more processors, or a processor that supports 
hyperthreading. In addition, multiprocessing requires a Professional license.  

To activate multprocessing, go to the Multiprocessing page and choose the appropriate level of 
multiprocessing support. You can try different settings to see the effect. For a dual-processor computer, 
four threads seems to work the best.  

Miscellaneous options 



 19 

 

Some additional options are located on the Other page.  

The "Use muted colors for icons" option will desaturate the icons in the Noise Ninja user interface so that 
they are less distracting.  

The "Animate selections" option activates a marching-ant effect for the filter preview rectangle and for 
profile selections. These can make the selections easier to see, but some people prefer a static display. 

The "Zoom on load" option determines whether an image is fit within the viewing window, or zoomed to 
100% magnification when the image is loaded. Since you normally want to preview noise filtering at 100% 
magnification, this option can save a step in the work cycle. 

The "Filter preview size" option determines the dimensions of the noise filter preview rectangle. On a 
slower machine, a smaller rectangle might make the filter tool more responsive and easier to adjust. 

 

��
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Useful concepts 
This page describes some concepts and terms that are helpful for getting the most out of Noise Ninja.  

"What's This?" help and Overview buttons 

The user interface is annotated with "What's This?" pop-up help. To use it, click on the "What's This?" 
button: 
 

        
 
Then click on an item in the user interface to see a description. Alternatively, move the mouse over an item 
and press the F2 key. Note that What's This help is usually more detailed than the tooltips that display when 
you hover the mouse. In addition, several tools and dialogs have Overview buttons that will display 
summary information:  
 

       

The YCrCb color space 

Most digital images are represented using the RGB color space, which decomposes each color into a red, 
green, and blue component. During filtering and profiling, Noise Ninja converts images into another color 
space called YCrCb. In this scheme, each color is represented as a luminance (brightness) value, a red-
green chroma value, and a blue-yellow chroma value.  

The luminance component normally contains the majority of actual information in an image. From an 
information-theoretic point of view, color adds relatively little information to an image. Another way of 
stating this is to say that color has a lot of redundancy in it -- nearby pixels tend to have the same color, so 
the color is not helping to distinguish them. In contrast, luminance information normally captures most of 
the edges, textures, and other detail in an image. 

Not surprisingly, luminance noise and chroma noise tend to have different characteristics. By separating 
them, Noise Ninja can do a better job of filtering each type of noise.  

There are a few places in the user interface where the YCrCb color space is exposed. One is in the profiling 
chart, where you can view noise levels for each YCrCb channel. Another is the channel selector in the main 
window, which allows you to view individual YCrCb or RGB color channels.  

Profiling vs. filtering 

Noise reduction involves two distinct concepts. Profiling characterizes noise in an image. Generally, 
profiling describes how much noise is associated with different colors, tones, and spatial frequencies 
(resolutions). Filtering is the actual removal of noise. Filtering uses profiling information to estimate the 
amount of noise in the image, and it has additional parameters to control how aggressively the noise is 
suppressed. 
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Workflow 

In discussions of digital photography, you'll often hear the term "workflow". This simply refers to the steps 
that an image goes through, from the time it is exposed in the camera, to the point at which it is published. 
Workflow is different for every user and organization, and it can involve a variety of software applications 
and adjustments.  

Noise Ninja is just one piece of the digital workflow. As such, a decision needs to be made about where it 
should be used within the overall workflow. Generally speaking, it is best to apply noise reduction as early 
as possible, before other adjustments have shifted pixel values and noise values around. For instance, 
histogram stretching, color balancing, and sharpening can distort noise levels and make it more difficult for 
Noise Ninja to remove noise. (Modest in-camera adjustments are usually not problematic, especially if you 
create noise profiles that account for them.) On the other hand, sometimes it is impractical to use Noise 
Ninja before other steps. In the end, it depends on your particular workflow, your objectives, and your 
preferences, and some experimentation may be required to find the optimal strategy. 
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Staying up to date, and upgrade policies 
Updates of Noise Ninja are posted at www.picturecode.com/download.htm  

Different versions of Noise Ninja are numbered using a decimal scheme, where the number to the left of 
the decimal is the major version and the number on the right of the decimal is the minor version. For 
instance, version 2.0 has a major version of 2 and a minor version of 0.  

When you purchase a license for Noise Ninja, it will work with all subsequent minor version updates for 
the same major version. For instance, if you purchase a license for version 2.0, it will also work with 2.1, 
2.2, and so on. Just download the update, and your existing key will work with it. You do not need to 
purchase a new key. 

Major version updates -- for instance, from 2.1 to 3.0 -- might require purchase of a new license key. The 
new key might be offered with an upgrade discount. Also, each key has an issue date encoded in it, so the 
discount might vary according to when the key was issued. (For instance, you might not be charged, or you 
might receive a larger discount, if you purchase a key 30 days before a major update.) Realize, however, 
that the discount policy for major upgrades is not fixed, and any discounts will be determined uniquely for 
each major release.  
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Introducing noise profiles 
Noise profiles are the key to getting good results with Noise Ninja. A noise profile characterizes how noise 
varies with parameters like ISO, brightness, color, and resolution. For instance, they allow Noise Ninja to 
"know" that noise in an ISO 1600 exposure is very high in the shadows but low in well-exposed highlights, 
or that the blue channel in a film scanner has more noise than the green channel, or that luminance noise is 
stronger than chroma noise for a particular camera. Noise profiles thus provide crucial information for 
distinguishing noise from detail. 

While profiles might sound a little technical, don't worry, they are very easy to work with. Usually, you 
only need to click a button to work with profiles. 

Before you can remove noise from an image, you need to load or create a noise profile. To do this, activate 
the Noise Profiler tool: 

 

Note that each open image in Noise Ninja has its own profile. So, when you load or create a profile as 
described below, it only affects the profile for the active image. 

Loading an existing profile 

If you already have noise profiles that characterize your camera or scanner, you can load one of them using 
the Open Profile button: 

 

By convention, noise profiles are stored in the NoiseProfiles folder in the Noise Ninja installation directory. 
You should load a profile that most closely matches the image that you are trying to filter. At a minimum, 
try to find a profile for the same camera model, image size, and ISO sensitivity.  

Note: You can download profiles for many cameras from 
www.picturecode.com/download.htm These profiles are typically created for "generic" 
settings for in-camera sharpening and other parameters. While they yield good results in 
many cases, if you use substantially different settings in your camera you might obtain 
better results by creating a custom profile. For instructions, see “Profiling a camera or 
scanner.” 

Note: Noise Ninja also includes an automatic profile loader that selects a matching 
profile when you open an image, based on annotations in the profiles and EXIF data in 
the image. See “The Automatic Profiler” for details. 

Profiling your camera or scanner 
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If you don't already have a suitable profile for your camera or scanner, then you can create custom profiles 
yourself. It is easy to do and it only takes a few minutes. For instructions, see “Profiling a camera or 
scanner”. 

Creating a profile from a noisy image 

If you don't have access to the camera that produced an image, or if you are simply in a hurry, then you can 
create a profile directly from the image that you are trying to clean up. This will often yield acceptable 
results, but it should not be relied upon too much, because it usually takes more time than loading a pre-
defined profile, and because many images have too much detail to allow a good profile to be made.  

Automatic profiling 

The easiest way to create a profile from the image is to click on the "Quick Auto Profile" button: 

 

Noise Ninja will automatically scan for detail-free regions in the image and measure the noise. However, 
the auto profiler is not infallible. It includes a number of heuristics for detecting detail-free regions, but 
some textures look like noise to it. So, the auto profiler may overestimate the amount of noise in the image. 
Also, some images have too much detail in some brightness or color ranges, so the auto profiler will not be 
able to select patches in those areas. In such cases, the profile may over- or under-estimate the noise in 
parts of the image that it cannot analyze. 

There is also a Full Auto Profile command. This is recommended for use with special profiling charts, 
which are used for creating camera profiles. The Quick Auto Profile feature is faster than the Full Auto 
Profile command, especially on large images. It does not scan the image as thoroughly, but it usually 
produces similar results for normal images.  

Manual profiling 

The second way to build a profile from a noisy image is to select patches manually. To do this, toggle the 
manual profiling button to the "on" position: 

 

Use the mouse to select patches that do not contain any detail and which are uniform in color and 
brightness, Try to select enough patches to cover a range of brightness levels and colors. Noise Ninja will 
force each patch to be at least 16x16 pixels in size. Where possible, you should select patches that are 
larger, around 100x100 pixels. Avoid extremely dark or extremely light patches where clipping might have 
occurred.  

Right-click or control-click on a patch to remove it. Click the red arrow to reset the profile and start over. 

You can also use the manual profiling tool to fine-tune profiles created with the automatic profiler. 
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Annotating profiles 

If you intend to reuse a profile with other images, it is a good idea to annotate it with the camera model, 
settings, and other information that might be relevant. Certain annotations are required if you wish to use 
the automatic profile loader. See “Profile annotations” for details about profile annotations. 

Saving a profile 

To save a noise profile, click on the Save Profile button: 
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Profiling your camera or scanner 
By profiling your camera or scanner, you can improve the consistency of noise reduction, and you can 
improve the productivity of your workflow. The basic idea is to characterize the noise for your camera 
under a range of typical operating conditions, and reuse those profiles when you are removing noise from 
images. 

It is easy to profile a camera, and it only takes a few minutes. The steps are explained below. 

1. Display or print the profiling chart 

A profiling chart is included with the Noise Ninja distribution files. It is name calibration_chart.jpg, and it 
is located in the root of the installation directory. You can view it by selecting "Open profiling chart" 
from the File menu in Noise Ninja. The chart looks like this: 

 

Display the chart on your monitor, or print it out on any photo-quality inkjet printer. Don't worry about 
color accuracy. The Noise Ninja profiler only needs to see a range of colors and tones that reasonably cover 
the gamut; the precise color values are not important.  

Note: You can order a high-quality printed chart from www.picturecode.com. See the 
Purchase page on the site. 

2. Photograph the chart 

Set your camera as you normally do. For each ISO setting, take an out-of-focus photograph of the profiling 
chart. The defocusing should be enough that any dot patterns from the monitor or texture in the chart paper 
are eliminated. Otherwise, they could be mistaken for noise by the profiler. 

3. Create profiles 

Load each image into Noise Ninja and activate the Noise Profiler tool. Click the Full Auto Profile button 
to create a profile from the image: 
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If you prefer, you can also create a profile using manual selection. Or, you can use the manual profiling 
tool to make changes to the automatically-generated selections.  

4. Annotate profiles 

Click the Profile Annotation Editor button to assign annotations to the profile: 

 

This is particularly important if you intend to use the profiles with the automatic profile loader. It is best to 
use the Auto Fill button in the annotation editor to fill in fields directly from the EXIF data in the image (if 
present). See “Profile annotations” and “The automatic profile loader” for more information.   

Profiling a scanner/film combination 

The procedure for profiling a scanner is identical to the one outlined above, except that you need to process 
and scan the film normally after photographing the chart.  

Realize that noise is a function of the combination of the scanner and film, because of the way the film 
grain interacts with the scanning process. So, as a general rule, you will need to profile each type of film 
that you use with a particular scanner. 

If you have a Q60 (IT8) slide target for the particular film that you use, then you can use that instead of 
taking photos of the Noise Ninja profiling chart. Just scan the target like you normally do, and then create a 
profile from the scanned image.  

If you use a Q60 target, you might need to build the profile manually instead of with the Full Auto Profile 
feature. The Q60/IT8 targets have a number of similar patches located next to one another. This might 
confuse the automatic profiler, which tends to perform better when there are high-contrast edges to separate 
patches. If you build the profile manually, you don't need to select every patch in the target. Just select 
enough to cover a representative sample of the color and tone gamut. 
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Profile annotations 

Each noise profile can be annotated with the camera settings and other conditions under which it was 
created. Annotations serve multiple purposes. First, they provide an "audit trail" indicating the conditions 
under which a profile was created, so that individual users can determine whether a particular profile is a 
good fit for their particular shooting preferences. Second, they are used by the automatic profile loader to 
automatically find the "best" profile for a given image. 

The Edit Annotations button on the Noise Profiler panel will launch the annotation editor dialog: 

 

The dialog contains more than a dozen fields that you can fill in.  

The Clear button will reset all fields to undefined.  

The Auto Fill button will attempt to read EXIF data from the current image and fill in corresponding 
values automatically. It will only change a field if it can locate corresponding data in the EXIF record. So, 
depending on the situation, you might want to hit the Clear button first, to erase any spurious values from 
an existing profile. 

The Manufacturer and Model fields should always be filled in if possible. (For film scanners, the Film field 
should also be filled in.) These fields are mandatory for use with the automatic profile loader and the 
automatic profile directory creation feature. Whenever possible, these fields should exactly match the 
corresponding fields in the EXIF data for images from the same camera. For instance, the EXIF data in a 
Minolta A2 reports the Maker to be "Konica Minolta Camera, Inc." (note the comma and period), and the 
Model is "DiMAGE A2". The automatic profile loader ignores whitespace, but other characters are 
matched exactly, so it is important to fill these fields in accurately. The "Auto Fill" button is especially 
useful for this. You can also use the EXIF Viewer tool in Noise Ninja to examine EXIF data in an image. 

Note: Some cameras report different Model values in different regions of the world. In 
you are using an Asian version of the Canon Digital Rebel, for instance, you might need 
to edit the Model annotations in profiles that were created using the American version of 
the same camera. 

See the discussion of "How many profiles do I need?" for more information about the relative importance 
of different annotation  
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How many profiles do I need? 

Noise Ninja's noise profiles can contain more than a dozen annotation fields, covering everything from the 
camera model and camera settings, to the ambient temperature. All of these things can affect noise, but that 
does not mean that you have to create profiles for all the possible combinations of values. Normally, you 
will shoot with most settings nearly the same for all images, and you'll be varying only one or two 
attributes like ISO. Also, some parameters like shutter speed have negligible effect in "normal" shooting 
conditions.  

Here is an approximate grouping of the relative importance of different attributes: 

• High importance: Maker, Model, ISO, and Megapixels. For scanners, Film and Multisampling 
are important.  

• Moderate importance: Sharpness, Saturation, Contrast. Depending on the camera, a profile 
created using the lowest in-camera settings for these values might not yield good results on an 
image that was taken with the highest values for these same settings. However, the differences 
may be negligible for values that are close. 

• Low importance, or camera/application dependent: Temperature, Shutter Speed, Illuminant, 
Quality, Color Space. Extreme values for these might be important. For instance, outdoor 
astrophotography may involve abnormally long exposures and/or cool temperatures.  

For best results, try to create sets of profiles covering the "High Importance" attributes, with the "Moderate 
importance" attributes at or near the settings you use in day-to-day shooting. For specialized applications 
(for instance, long exposures or extreme outdoor temperatures), you might want to create profile sets that 
cover relevant ranges of those variables, too. 

The key is to hold most things relatively constant, and not to worry about things that don't matter.. For 
instance, for a given camera, the Maker, Model, Megapixels, Sharpness, Saturation, Contrast, Quality, and 
Color Space will change only infrequently for most photographers. The difference between RAW and 
JPEG Fine quality might be negligible in some workflows. Shutter speeds between, say, 1/8000 second and 
a few seconds might have little effect on noise levels (though this depends on the camera). Illuminant and 
temperature probably don't have a big influence over the normal range of shooting conditions (though CCD 
cameras in particular may be sensitive to temperature when combined with long exposure times). 

Don't get overly concerned about having a "perfect" profile. Noise removal is inherently heuristic, and there 
is some latitude in the noise estimates. As long as your profiles are getting you "in the ballpark" you should 
be okay. However, the flexibility is available to handle special circumstances, and annotations can help you 
to know whether a particular profile set is likely to yield good results for your particular shooting 
preferences. 
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The automatic profile loader 
Noise Ninja includes an automatic profile loader that selects the "best" noise profile when you open an 
image. It depends on profile annotations. When it is set up correctly, it works almost transparently. 
However, it is recommended that you read through this entire section to be aware of some of the 
requirements and idiosyncrasies of the auto loader. 

The auto-profiler can be enabled or disabled via an option on the Profiles page of the Preferences dialog. 

In a nutshell, here's how the automatic loader works: 

1. The image is scanned for embedded EXIF data like Manufacturer, Model, ISO, sharpness, and 
about a dozen other attributes.  

2. Attributes which are not obtained from the EXIF data are optionally filled in using default values 
supplied by the user (see below). 

3. Given EXIF Manufacturer and Model values of <manufacturer> and <model>, respectively, the 
automatic loader looks in the Noise Ninja installation directory for a folder named 
NoiseProfiles/<manufacturer>/<model>. For instance, if the Manufacturer is "Canon" and the 
Model is "CanonEOS-1Ds", the automatic loader will look for a folder named 
"NoiseProfiles/Canon/CanonEOS-1Ds/" within the Noise Ninja installation directory. 

4. If the folder exists, the automatic loader scans all profiles in the folder and all child folders, and it 
reads the annotation data for each profile. It identifies the profile with annotations that best match 
the attributes of the image. This profile is loaded automatically, and the title bar of the main 
window will display "Matched <profile>", where <profile> is the name of the loaded profile. All 
the scanned profile annotations are cached, so next time the same camera model is needed, they 
won't be loaded from disk again. 

5. If the folder does not exist or if the matching process fails for some reason, the automatic loader 
will reuse the last profile that was loaded. In this case, the title bar will display "Using previous". 
This "previous profile" is remembered across invocations of Noise Ninja.  

How attributes are weighted 

During the matching process, the Maker, Model, ISO, and Megapixels attributes normally carry the most 
weight. For film scans, the Film and Multisampling fields also carry high weight. Sharpness, saturation, 
and contrast have medium influence. The remaining fields normally have low influence, though it depends 
on the specific profile set and the magnitude of differences between values. See the discussion about "How 
many profiles do I need?". 

Required and optional attributes 

Matching will fail if the Maker, Model, or ISO are undefined either in the image attributes (after default 
substitution) or in the profile annotations. Other attributes or annotations are optional, though missing 
values may cause a profile to earn a lower ranking during matching.  

Guidelines for using the profile loader 

Once it is set up correctly, the automatic profiler can be very effective and convenient. To ensure that it 
works as expected, you should adhere to the following guidelines: 
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• In the Preferences dialog, make sure the you have checked the options for automatically creating 
profile directories, and for enabling the automatic profiler. 

• If you download profiles from PictureCode or some other source, use the "Install noise profiles" 
function in the "File" menu to copy the profiles to the correct folder. The "Install noise profiles" 
function reads the Manufacturer and Model annotations in each profile and ensures that the profile 
is copied to the correct subdirectory in the NoiseProfiles folder. 

• Make sure you have both read and write permission for the NoiseProfiles folder. 

• When you annotate the Manufacturer and Model fields for a profile, try to use the Auto Fill button 
in the annotation dialog to initialize the fields directly from the image EXIF data. This will 
minimize the chance of typographical mistakes or other errors that might prevent the automatic 
loader from matching a profile to a camera. 

• Use the "Edit Auto-Loader Defaults" dialog to establish reasonable default values to use when 
EXIF data is not available:  
 

 
 
This can make the automatic loader useful for scanned images, for instance, where little or no 
EXIF data is likely to be present, and where you are likely to be processing several images at a 
time with the same attributes (scanner model, film type, film ISO rating). 

• Look in the title bar to see whether the auto-loader succeeded. You will see "Auto matched" and 
the profile name in the title bar after a successful match. "Using Previous" means the match failed 
and the previous profile is being used. "New profile" means there was no previous profile, or the 
profile has been cleared. 

Keep it simple 

In general, try not to make the matching process too difficult for the auto-loader. It has to optimize within a 
15-dimensional space, and that is not always an easy thing to do. The auto-loader tries to make intelligent 
choices when there is not an obvious match, but this can lead to some non-intuitive results. For instance, if 
you only have profiles for 6 megapixel images, and you use the auto loader for a 3 megapixel ISO 1600 
image, the auto loader might pick an ISO 800 profile. This is because the downsampling process used to 
create a 3-megapixel image from a 6-megapixel sensor also reduces noise levels. There are a number of 
relationships like this that the auto-loader attempts to consider. However, these relationships are most 
reliable when they do not involve large differences in parameter values.  

So, to increase the reliability of the matching process, and to make it less likely that you will be confused 
by the automatic selections, try to use or create profile sets that are already well matched to your shooting 
preferences. 

Working with crops and reduced-size images 

It is recommended that you work with full-size images instead of crops. This will avoid potential ambiguity 
in the profile matching process.  
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By default, Noise Ninja assumes that the dimensions of the image denote the full resolution, not a crop. It 
attempts to match this value against the Megapixels annotations of existing profiles. For instance, if you 
have profiles for both 3 megapixel images and 6 megapixel images from the same camera, then Noise 
Ninja will match a 3 megapixel image against the 3 megapixel profiles. 

Downsampling reduces noise levels, but cropping does not change noise characteristics. So, if you try to 
filter a 3 megapixel crop from a 6 megapixel original image, Noise Ninja will match the wrong set of 
profiles. 

One way to avoid this problem with crops is to set the Megapixels field in the Autoloader Defaults dialog: 

 

(Be careful not to confuse this dialog with the Annotation Editor dialog, which has similar fields.) If you 
set the Megapixel field in the Autoloader Defaults dialog, then Noise Ninja will assume that this is the 
uncropped size of all images that you try to filter. So, it will try to select profiles for this size even if you 
open a cropped image. If you are working with reduced-resolution images, however, you should leave the 
Megapixels field set to the default setting of "---". 

If you work with reduced-resolution images, it is best to create profiles specifically for that resolution. 
Otherwise, Noise Ninja will select a higher-resolution profile, but it will try to select a lower ISO to 
compensate for the reduced noise in the downsampled image. For instance, if you have profiles for 6 
megapixel images and then you open a 3 megapixel ISO 400 image, Noise Ninja might select a 6 
megapixel, ISO 200 profile. This is probably a better choice than the 6-megapixel ISO 400 profile, but it 
might not be as good as a profile created specifically for 3-megapixel ISO 400 images. 

Other comments (and a note for Sony camera owners) 

Regional variations in EXIF data: Realize that the Model field for some cameras varies in different 
regions of the world. For instance, if you are using a camera bought in Asia with profiles created using the 
American version of the same camera, you might need to change the Model annotations in the profiles and 
re-save them (with the automatic directory naming function enabled). 

Sony camera owners: Several Sony cameras use the same name -- "Cybershot" -- for the EXIF Model 
field. If you use one of these cameras, then you will need to go to the NoiseProfiles/Sony/Cybershot/ 
directory and move the profiles for other models to another directory.  

Automatic profile naming: In the Preferences dialog there is an option to automatically name profiles, 
using a mnemonic scheme derived from the annotation values. This feature is not necessary to use the auto 
loader. The auto loader ignores the actual profile names. Instead, it looks at the annotations that are stored 
inside the profile. The automatic naming scheme may make it easier to distinguish different sets of profiles 
for the same camera. However, if you prefer another naming scheme, feel free to use it. 

Proprietary or missing ISO data: Some cameras store ISO and other information in a proprietary, 
undocumented EXIF field called the MakerNote. Noise Ninja can read some MakerNote fields, but not for 
all cameras. Usually, it can find enough information to make a match. However, two things in particular 
can interfere. First, ISO information is sometimes removed by other software applications when it is stored 
in the MakerNote field. Second, the "Auto ISO" mode available on some cameras might not store the actual 
ISO used for an image in a place where Noise Ninja can read it.  
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Removing Noise 
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The Noise Filter 
After you have loaded or created a profile, you are ready to remove noise from the image. First, activate the 
Noise Filter: 

 

There are two sets of filter controls, the "Standard" settings, and the "Color-selective" settings. The 
Standard filter settings apply to the entire image. The Color-selective settings are used to adjust filtering for 
specific colors, which is occasionally useful for grass or other textured areas of a single color. 

Tip: Zoom to 100% magnification when you are working with the filter tool. This will 
make it easier to see both the noise and the effects of noise reduction when you are 
adjusting the filter settings. 

The preview rectangle 

If you don't see the green preview rectangle, then click anywhere in the image to activate it and position it.  

The preview rectangle shows the effects of the current filter settings. When you make adjustments to the 
settings, the preview rectangle is updated. If you have a slow machine, you might want to choose a smaller 
preview size in the Preferences dialog, so the preview will be updated more quickly. 

You can turn off the preview off by right-clicking or control-clicking in the image.  You can also toggle the 
Preview button: 

 

Removing noise 

The individual filter controls are described below. Usually, if the current noise profile is matched correctly 
to the image, the default settings will yield reasonable results. In any event, after the settings are adjusted to 
your liking, hit the remove noise button to filter the entire image: 

 

After you filter the image, you can use the Before button to toggle between the unfiltered and filtered 
image: 
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Press and hold the button to view the unfiltered image. If you want to go back and refilter with different 
settings, you can go to the Edit menu and choose Undo, and the unfiltered image will be restored. 

Using the standard filter controls 

The Standard filter page includes three groups of controls. The luminance group affects filtering of noise 
in the brightness component of an image. This is usually the part of the image that contains the most real 
information. The colors group controls filtering of color noise, which is often the most displeasing noise. 
The sharpness group enhances edge sharpness using an unsharp mask. 

Strength controls how aggressively the filter is applied. This is the control that you'll normally want to 
adjust if you don't like what you see in the preview rectangle. If you move it far to the right, the image may 
look too plastic-like. If you move it to the left, it will look more grainy. Often the most natural-looking 
results are achieved when you leave a modest amount of grain. The human eye tolerates a certain amount of 
noise when it is accompanied by detail, and the luminance channel contains most of the detail in an image. 

Smoothness increases or decreases the noise levels estimated by the Noise Profile. Usually the default 
setting is adequate, but if you see isolated specks in smooth areas, try increasing the smoothness setting to 
see if they go away. (Here's a tip for adjusting the Smoothness slider: Move the preview window to a 
smooth background areas, and move the Strength slider all the way to the right so the preview is a smooth 
as possible. Then set the Smoothness slider to the minimum level such that the preview is still smooth (if it 
is too low, you will usually see isolated specks). Finally, lower the Strength slider until you like the 
results.) 

Contrast and saturation apply a scaling factor to edges, similar to an unsharp mask, but at several 
resolutions simultaneously. You probably won't need to adjust these in most situations. 

Sharpness amount and sharpness radius apply a conventional unsharp mask to the filtered image. Some 
people prefer to set the amount to zero and do sharpening later in the workflow. However, even in that 
case, it can be useful to preview the sharpening effect to see how it interacts with the noise reduction. The 
Suppress halos option eliminates unnatural highlight artifacts that can occur when high sharpening levels 
are used 

In addition, there are some controls at the top of the panel. Filter coarse noise is occasionally useful when 
an image has very low-frequency noise, usually in the color channels. Turbo mode takes a few shortcuts to 
accelerate filtering. Usually the difference in quality is negligible, but sometimes strong diagonal edges 
may show some aliasing artifacts ("jaggies").  

A trick for adjusting the standard controls 

Here is a quick and easy strategy that often yields excellent results: 

1. Move the preview to an area that should be smooth. 

2. Move the Luminance Strength slider all the way to the right.  

3. Adjust the Luminance Smoothness slider to the lowest setting possible without introducing 
obvious speckling. The preview area should be smooth. 

4. Now, reduce the Luminance Strength slider until you like the balance between detail and 
smoothness.  
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Using the color-specific filter controls 

The color-specific filter allows you to increase or decrease filter strength for particular colors. This can be 
useful for images with green turf, blue sky, or other color areas where you want to modify filtering 
selectively. [See also the description of the Noise Brush, which is sometimes an easier way to selectively 
modify the filter.]  

To use the color filter, click on the eyedropper button: 

 

Next, click on one or more pixels in the image. The eyedropper averages a 3x3 region. Each time you select 
a pixel, the correponding color will be highlighted in the color grid. Move the slider to increase or decrease 
filtering for that color. The preview window will be updated to show the effect. (Toggle the eyedropper 
button off to move the preview rectangle.) 

You might need to make several selections close together in order to cover the intended color range 
adequately. Also, try to avoid making significantly different adjustments to similar colors, as this may lead 
to unexpected artifacts when nearby pixels that are close in color are pulled in opposite directions.  

Saving and reusing filter settings 

You can save filter settings directly to a file by clicking on the "Save Settings" button: 

 

You can also embed filter settings in the current noise profile by clicking on the "Save to Profile" button: 

 

Next time you load the profile, the settings will be loaded along with it. This allows you to create a profile 
and tune the settings for a particular camera and reuse them on subsequent images with little or no 
adjustment required -- just load the image, load the profile, and hit the "Remove Noise" button. 

Touching-up results 

A useful tool called the Noise Brush is available for fine-tuning noise reduction results. See the “Noise 
Brush” section for details. 
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Fine-tune results with the Noise Brush 
The Noise Brush allows you to selectively undo or fade the effects of noise removal. You simply brush on 
parts of the image where you want to reduce the amount of filtering. This is typically useful in cases where 
the filter has been too aggressive in areas of fine texture, which may be difficult to discern amid noise. 
Thanks to the Noise Brush, you are not left at the mercy of the noise reduction algorithm when you 
disagree with its decisions. 

To use the brush, activate it by clicking on the Noise Brush selector button: 

 

Now, paint with the mouse over the area that you want to undo or fade. If you change your mind, you can 
right-click or control-click to reverse the effect of the brush. Also, you can undo/redo individual brush 
strokes or all brush strokes using the corresponding buttons: 

 

There are several controls that you can adjust to modify the behavior and size of the brush: 

• Mode This controls the basic operation of the brush. In Undo mode, pixels in the filtered image 
are blended with pixels from the original image. In Redo mode, filtered pixels are blended back in. 
In either mode, you can reverse the operation of the brush by right-clicking or control-clicking. 

• Channel You can apply the brush to the luminance channel, the color channels, or all channels of 
the image. Usually, you will get the best results by working in the luminance channel. Most detail 
is contained in the luminance channel, so you can fine-tune in this channel without reintroducing 
color noise (which is often more displeasing than luminance noise).. 

• Edge type With a soft edge, the blending action of the brush is strongest in the center and 
weakens gradually toward the edge. With a hard edge, the blending action is uniform across the 
brush area. 

• Radius This controls the size of the brush. 

• Strength The strength slider controls the degree of blending in each stroke.  

You can also adjust the size and strength of the brush by moving the corresponding sliders. The brush 
pattern is displayed when you make changes to the size or strength. 

Using the Noise Brush after batch processing 

The Batch Processor allows you to filter many images automatically while you do other things. However, 
you can still use the Noise Brush on batch-processed images: 
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1. Open the filtered image that you want to touch-up with the Noise Brush. 

2. Use the "Load undo buffer" command in the File menu to open the corresponding original image. 
This will load the unfiltered image into the undo buffer of the filtered image. 

3. Now you can use the Noise Brush normally on the filtered image.  
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Batch processing 
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Overview of the Batch Processor 
The Batch Processor dialog applies noise reduction automatically to multiple images. You can specify one 
or more directories of images to be included in the batch. For each directory, you can specify various 
options for selecting input images, filtering them, and saving the results. 

To launch the dialog, select the "Batch Processor" command from the File menu. 

Note: The Batch Processor dialog is extensively annotated with "What's This" help. Click 
on the "What's This" button and then click on an individual control in the dialog to view a 
description of the item. The documentation on this page provides a high-level 
introduction to the batch processor. For details regarding individual settings, display the 
dialog and use the What's This help. 

The basic workflow for creating and executing a batch is as follows: 

1. Click the "Add directory" button to add a folder to the current batch. You can add multiple 
folders. Each folder has its own settings. 

2. Adjust settings on the "Input options" page to control which files from the current folder will be 
processed. 

3. Click on the "Output options" tab to access controls for selecting the destination directory and 
output file format.  

4. Use the "Filtering options" page to determine how profiles are selected for each file and what 
filter settings are used. 

5. Click the "Execute" button to process the batch.  

As you change settings, the file list for the currently selected directory is updated. The file list shows which 
files will be processed in the directory. For each file, it displays the destination file name, the noise profile 
that will be used, the filter settings that will be applied, and an indication of whether there are any naming 
conflicts or other errors. (Note that it may take a few seconds for the file list to update if you have a slow 
machine or if the selected directory contains hundreds of files.) 

When you execute a batch, the Log page displays. This page records each file that is processed along with 
any error messages. The Cancel button can be used to terminate a batch before it has finished. The Hide 
button will make the main window and batch dialog disappear from your desktop. You can use your 
window manager's task bar or docking area to show the windows again. 

Enable the Background checkbox to give lower processing priority to the batch while you use other 
applications. 

Note that you can use the Noise Brush to touch-up batch-processed images. See “The Noise Brush” for 
instructions. 
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Shortcuts 
[On Macintosh, use the "Command" key instead of the "Control" key in the sequences below.] 

View "What's This" help: Move the mouse over an item and press the F2 key 

View original image: Press and hold the "B" key 

Zoom in/out: Use the mouse wheel 

Zoom in: Control + 

Zoom out: Control - 

Zoom to fit: Control 0 

Zoom to 1:1 magnification: Control Alt 0 

Scrolling/panning: Press the Space bar and drag the image with the mouse 

Undo: Control Z 

Redo: Control shift Z 

Activate filter preview: Click in the image 

Deactivate filter preview: Right-click or control-click in the image 

Open an image: Ctrl-O 

Close active image: Ctrl-W 

Save active image: Ctrl-S 

Save As: Ctrl-Shift-S 
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Miscellaneous features 
Noise Ninja includes several convenience features. These are briefly described below. 

The Rotate commands in the Tools menu can be used to change the orientation of an image. This is often 
useful for images that have been retrieved directly from the camera. 

The Revert command in the File menu loads the most recently saved version of the active file from disk. 
This is useful if you want to discard all your changes and start over. 

The Save checkpoint and Revert to checkpoint commands in the Edit menu can be used to save snapshots 
of the image that you can go back to later. For instance, you might want to save a checkpoint before using 
the Noise Brush, so that you can quickly go back to a known state if you decide to start over with the brush. 

The Info Viewer, EXIF Viewer, and IPTC Viewer tools display different types of metadata that might be 
associated with an image. They can be activated in the Tools menu, or by clicking on the corresponding 
button in the tool selector palette on the left side of the main window. 

The Open profiling chart command can be used to display the calibration_chart.jpg file that is located in 
the root of the Noise Ninja installation directory. 
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Frequently asked questions  

Q: Where should Noise Ninja be used in the workflow? 

It is usually best to apply noise reduction as early as is practical in the workflow. Post-processing 
adjustments like sharpening, contrast stretching, and color balancing can alter pixel values and noise levels 
in unpredictable ways. Depending on the amount of adjustment, this can make it more difficult for Noise 
Ninja to estimate noise levels. Sharpening, for instance, is a nonlinear operation that can significantly 
distort the distribution of noise values.  

If your workflow requires that you use Noise Ninja after some other operations, then try to create noise 
profiles using calibration images that have been put through the same operations.  

Q: Do you have a profile for camera XYZ? 

Current profiles are listed at www.picturecode.com/profiles.htm. If your camera is not listed there, it is easy 
to create your own profiles, and it only takes a few minutes once you understand the process. See “Profiling 
a camera or scanner” for instructions. If you create new profiles and would like to share them with other 
users, feel free to email them to us. You can also email calibration images and we will make profiles from 
them to include in the distribution files. 

Q: Do I need 8-bit or 16-bit output? 

An 8-bit file represents each pixel using three 8-bit values: one each for red, green, and blue, for a total of 
24 bits per pixel. A 16-bit file represents each pixel using three 16-bit values, for a total of 48 bits per pixel. 
In an 8-bit file, there are only 256 possible brightness levels for each color channel. In a 16-bit file, there 
are 65536 possible levels.  

16-bit files hold up better to subsequent image adjustments like contrast stretching or color balancing. 8-bit 
images will tend to show obvious posterization artifacts or contouring even after modest adjustments. Dark 
shadows, for instance, have very few bits of useful information in an 8-bit file, so they exhibit visible steps 
in color values when they are lightened. Gradient areas of the same color can also show banding or steps 
after adjustments. 

So, if you expect to make substantial adjustments to images after filtering them with Noise Ninja, then 16-
bit output is recommended. However, if you only intend to make minor adjustments before printing or 
displaying the images, then 8-bit output will probably be adequate. Professional workflows typically use 
16-bit files because it allows fine control over tonality and color with less risk of introducing objectionable 
artifacts. 

Internally, Noise Ninja processes all images at 16 bits or 32 bits per channel, in both the Home and Pro 
editions. Conversion to 8 bits only happens when you save the file to disk in 8-bit mode. 
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Contacting PictureCode 
The PictureCode website is located at www.picturecode.com 

A support web page is located at www.picturecode.com/support.htm 

Email can be sent to support1@picturecode.com. We try to respond to all email messages, usually the same 
day they are received. 

Press and reseller inquiries should be sent to info1@picturecode.com 

  

  

 

 

  

 

 


